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Airbrush for the uniform distribution of a defined concentration of E. pisi conidia on the leaves of pea plants
Uniformity index and a semi-automated image analysis-based quantification of disease symptoms. The uniformity
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of powdery mildew disease severity at macroscopic and molecular levels.

 Uniform and reproducible inoculum distribution on leaves using a simple and inexpensive
spray device

+ Rapid and reproducible quantification of powdery mildew disease symptoms using open-
source software without the requirement of computational expertise
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Background

Powdery mildew caused by the obligate biotrophic fungal pathogen Erysiphe pisi is a devastating disease that limits the productivity
of leguminous crops, including pea, lentils, and Medicago species [1]. The fungus infects only the aerial parts of the plant, particularly
the leaves, and produces white powder-like disease symptoms, representing the epiphytic mycelia and asexual reproductive structures.
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A fundamental requirement of powdery mildew studies is a pathogen inoculation method that is simple and reproducible, provides
control over the initial inoculum concentration, and ensures uniform conidia distribution across the plant surface so that fungal
growth stages and visual disease symptoms can be precisely quantified at microscopic and macroscopic levels, respectively.

The conventional methods for powdery mildew inoculation include tapping or brushing conidia from a heavily infected leaf directly
on a plant (e.g., [2]) and dusting conidia over a nylon mesh fixed on a settling tower and allowing the conidia to slowly settle on the
plant by gravity (e.g., [3-6]). While the tapping and brushing methods are easy to perform and do not require special equipment, they
do not offer any control over the initial inoculum concentration and result in uneven distribution and clumping of conidia, reducing
the number of isolated colonies for accurate quantification of fungal growth stages. The settling tower method mimics the natural
infection process and produces isolated colonies but extends minimal control over the initial inoculum concentration and requires
large amounts of inoculum for infection (typically one to two fully infected leaves per tower) [5].

The liquid-based spray method, in which a conidial suspension is applied over the plant using a fine-spray apparatus, is an alternate
but less commonly used powdery mildew inoculation method that offers several advantages over the conventional methods. First,
the inoculum concentration can be defined by the number of conidia/ml, enabling reproducibility across replicates. Second, the
spray droplet size can be controlled using a fine spray nozzle and surfactants like Tween 20 [7], facilitating uniform distribution
of the inoculum across the leaf surface. Third, the spray method requires far less inoculum than the other inoculation methods,
with conidia from a single leaf sufficient to inoculate multiple plants. Previously developed spray inoculation methods either use
specialized devices that are not easy to replicate and/or are primarily suitable for the inoculation of excised leaf segments, not intact
plants [8-11]. Further, the Tween 20 concentration has to be carefully selected as it can adversely impact fungal germination [12].

In the present study, we aimed to develop a liquid-based spray inoculation method that uses a simple and inexpensive air spray
device to provide uniform and reproducible distribution of E. pisi conidia on the leaves of intact pea plants. We also aimed to develop
an image analysis-based quantification method to assess powdery mildew disease severity on pea leaves. Unlike earlier image-based
disease quantification methods that use complicated algorithms (e.g., [13-16], our goal was to develop a simple method that uses
open-source software and does not require any special computational expertise.

Method details
Plant and fungal material

Pea (Pisum sativum) cv. AP3 plants were grown at 22 °C in a controlled environment growth chamber (Conviron, Canada) with
a 16-h light/8-h dark cycle, 70% humidity, and photosynthetically active radiation of 170 umol m=2 s~1. Pure cultures of Erysiphe
pisi (Palampur-1 isolate; https://mycocosm.jgi.doe.gov/Erypi2/Erypi2.home.html) were maintained on AP3 pea plants grown in a
separate Conviron growth chamber under the above-mentioned environmental conditions.

Preparation of E. pisi conidial suspensions for spray inoculation

E. pisi conidia from an infected pea leaf showing white powder-like symptoms [12-14 days post inoculation (dpi)] was brushed
into 20 ml of 0.02 %, 0.03 %, 0.04 %, or 0.1 % Tween 20 solution. Each suspension was briefly vortexed to disperse the conidia
in the solution, centrifuged for 5 min at 4000 rpm to dislodge any conidia stuck to the tube walls, and then remixed by gentle
pipetting to uniformly disperse the conidia in the Tween 20 solution. The number of conidia in each suspension was counted using
a haemocytometer (Biirker-Tiirk, Ref-719505, Germany). A typical haemocytometer has two counting chambers, each with 9 square
grids (Fig. 1). A coverslip was placed on the counting chambers, and 10 pl of the conidial suspension was slowly dispensed into each
chamber through the gap between the coverslip and the slide using a micropipette. The haemocytometer was then observed under
the 10X objective of a light microscope (Olympus CX-23, Japan). The four corner grids with the larger squares were used for conidia
counting. Conidia counts from at least three technical replicates were averaged and used to estimate the final conidia concentration
using the following equation: Number of conidia/ml = Average number of conidia per grid/volume of 1 grid (ml); where the volume
of 1 grid = 0.1 cm x 0.1 cm x 0.01 em = 0.0001 cm® = 0.0001 ml. The suspensions were diluted to 10,000 conidia/ml using the
Tween 20 solution before inoculation. Higher conidia/ml concentrations can be used for inoculation but may not be optimal for the
quantification of fungal growth stages, which require isolated colonies. Conidial suspensions may be stored at room temperature for
up to 10 h without losing viability.

Spray inoculation of E. pisi conidia

Pea plants with 3-4 pairs of fully expanded mature leaves (~20 days old) were spray inoculated with the E. pisi conidial suspension
using an airbrush [Zorbes Spirit Air 0.4 mm Multi-Purpose Airbrush Compressor Spray) (Fig. 2)]. The leaves were sprayed from a
7-8 cm distance using the lowest airflow speed setting (Fig. 2b). After spraying, the plants were allowed to dry for an hour, covered
with a dome to maintain humidity (Fig. 2c), and placed in the dark for 24 h to facilitate conidia germination (Fig. 2d). The sprayed
leaves were harvested at different time points after inoculation to calculate the conidia uniformity index, and % conidia germination,
and to quantify the fungal load via image and gene expression-based analyses.
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Fig. 1. Conidia counting chamber used to estimate initial inoculum concentration a) A typical counting chamber or haemocytometer with two grid
chambers separated by a horizontal line b) A zoomed image of the haemocytometer grid with 9 large squares (one highlighted in grey) and each
large square containing 16 small squares c) Conidia present within the large square separated by triple line should be counted.

Trypan blue staining and microscopy

One-half of each infected leaf was cleared in 95 % ethanol and stained with 250 pg/ml trypan blue in a solution of lactic acid,
glycerol, and water (1:1:1) for 15 min. The samples were rinsed with the same solution and mounted with 50 % glycerol on glass
slides [17]. The stained leaf sections were observed under 50X magnification in a brightfield Zeiss Observer.Z1-AXIO microscope
(Carl Zeiss, Germany).

Calculation of conidia uniformity index (UI) and percent germination

We developed a grading system to evaluate the uniformity of conidia distribution on the leaf surface after spray inoculation. A
field of view (FOV) under a 50X magnification of the Zeiss Observer1.Z1 is a rectangular-shaped area of 0.06 cm?. We estimated that
a 3-4 cm? area half-leaf section would contain ~50-70 FOV. Based on the initial inoculum concentration of 10,000 conidia/ml and
~70-100 pl of spray volume per leaf, we estimated that, under optimal conditions, an entire leaf would receive ~700-1000 conidia
and a half-leaf would receive ~350-500 conidia. If the inoculum is distributed uniformly on the leaf surface, we expect to obtain 5-20
conidia/FOV. In addition to the number of conidia, the distance between conidia within a FOV was also considered in the grading
system. At least 30 FOV that contained conidia were captured per leaf section at 1 dpi. In the leaf samples sprayed with 0.002 % and
0.003 % Tween 20 suspensions, all FOV that contained conidia were captured as there were fewer than 30. From these FOV, five
images were arbitrarily selected for each Tween 20 concentration, and the number of conidia and distance between conidia were
measured. Based on this information, a grade between 1 and 10 was assigned to each FOV, as detailed in Table 1. These grades were
used to calculate a Uniformity Index (UI) with the formula:

[Total number of FOV with conidia/Total number of FOV in half-leaf] x FOV grade average/leaf section UI > 7 was considered
a highly uniform distribution of inoculum; UI between 4 and 7 was uniform; 1 to 4 was less uniform; and 0 to 1 was non-uniform.
The number of germinated conidia at the different Tween 20 concentrations was determined at 2 dpi from three sets of independent
experiments.
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Fig. 2. Spray inoculation using airbrush and plant setup a) Airbrush used for spray inoculation with optional settings for three air flow rates b) Pea
leaves sprayed with E. pisi conidia using the lowest air flow rate setting c) Plants covered with a plastic dome after spray inoculation, and d) placed
in the dark for 24 h.

Table 1
Grading system used for calculating the conidia uniformity index.

No. of conidia Distribution condition in a focal area Negative marking of 0.1 for each pair of Grade
conidia < 0.2 mm apart

5 to 20 All separate (>=0.2 mm apart) 0 10
10 pairs 10+10 x (-0.1) 9
5 pairs 10+5x (-0.1) 9.5
3 pairs 1043 x (-0.1) 9.7
All clumped 1/10th of ’all separate’ grade 1
1to4 All separate 0 5
2 pairs 5+2x(-0.1) 4.8
All clumped 1/10th of ’all separate’ grade 0.5
21 to 40 All separate 0 5
4 pairs 5+4x(-0.1) 3
All clumped 1/10th of ’all separate’ grade 0.5
>40 All separate 0 2.5
20 pairs 2.5+ 20x(-0.1) 0.5
All clumped 1/10th of "all separate’ grade 0.25

ImageJ-based quantification of powdery mildew disease symptoms and spray droplet size

The open-source software, ImageJ (https://imagej.net/ij/; version 1.54f) was used for the quantification of powdery mildew
disease symptoms. A previously established ImageJ protocol, designed to quantify bacterial colony size on media plates [18-19], was
modified to quantify the area covered by powdery mildew colonies on pea leaves (Fig. 3). The infected pea leaf and a physical ruler
placed in the same frame were photographed using a digital camera (NIKON D3500 DSLR). The scale of the image was set by opening
the captured image in ImageJ and converting it into the 8-bit format. The “Straight” line tool was selected from the toolbox, and
a line was drawn on the ruler covering a distance of 1 cm. The scale was set in the “Analyze” tab by changing the unit to cm and
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Fig. 3. Fungal area quantification using ImageJ a) Leaf image selected for fungal area measurement showing scale set to 1 cm based on the white
ruler photographed in the same frame b) Threshold auto-set between 0 and 255 as per the image pixel quality c¢) The Watershed feature delineates
the fungal area from the leaf background (outlined in yellow). d) Individual areas (black with yellow outline) are indexed and measured.

entering the length (1 cm) selected on the physical ruler. In the “Edit” tab, the image was inverted, and in the “Process” tab, the
“enhance contrast” option was adjusted to 75 %. The threshold of the image was adjusted between 0 and 255 in the “Image>Adjust”
tab so that only the fungal area was selected. The “watershed” function under the “Process>Binary” was selected to delineate the
region of interest (entire leaf) using the “freehand selection” tool. The “Size” tab under the “Analyze Particles” tool was set to 20
to 20,000 pixels to capture the maximum fungal area. We recommend optimizing the pixel range for each application as it depends
on the camera quality and the area of the region of interest being quantified. In the ‘Analyze Particles’ tab, the “Pixel units” and
“Summarize” options were selected to convert the total number of pixels covering the fungal area into cm?, and the percent leaf area
covered by the fungus was obtained. A macro was created for this analysis pipeline to run as a semi-automated plugin function in
ImageJ (Supplementary File S1). The spray droplet size and number were also measured using ImageJ, as described above.
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Fig. 4. Effect of Tween 20 concentration on inoculum droplet size a) Appearance of droplets on pea leaf sprayed with different Tween 20 solutions
b) Box and whiskers plot showing the distribution of spray droplet size and total number of droplets (provided above each box) per leaf for three
leaves per treatment. Statistical significance between treatments was computed using One-way ANOVA (p < 0.0001) along with Tukey’s multiple
comparisons tests (« < 0.05) and is shown by different lower-case letters.

RNA extraction, cDNA synthesis, and RT-qPCR for fungal quantification

Infected pea leaves (100 mg) were ground in liquid nitrogen, and total RNA was extracted using the Nucleospin RNA Plant kit
(Macherey-Nagel, Germany) with on-column DNase treatment per the manufacturer’s protocol. 1.5 ug of total RNA was used to
synthesize first-strand cDNA using the PrimeScript cDNA synthesis kit (Takara, Japan) per the manufacturer’s protocol. Two-fold
diluted cDNA was used for RT-qPCR using the 5X TB Green Premix qPCR mix (Takara-Bio Inc.) in a QuantStudio 6 Flex Real-Time
PCR system (Applied Biosystems, USA). Three biological replicates from three independent experiments were processed. Pea f-tubulin
2 (NCBI accession ID: X54845.1) was used as the endogenous control. Relative expression of E. pisi g-tubulin 2 (NCBI accession ID:
X81961.1) was calculated using LinRegPCR v. 2021.2 [20]. The primer list is provided in Table S1.

Method validation

One of the major factors affecting spray droplet size and number, as well as the uniformity of conidia distribution on the leaf
surface, is the concentration of the surfactant used in the spray suspension. To determine the effect of Tween 20 concentration on
the uniformity and reproducibility of the spray across leaf samples, we measured the number and size of the spray droplets on the
surface of pea leaves (Fig. 4a). The droplet number was higher and relatively more uniform across leaf samples at the higher Tween 20
concentrations (0.01 % and 0.004 %) than in the lower concentrations (0.002 % and 0.003 %) (Fig. 4b). Further, although, smaller
droplets were observed at the lowest (0.002 %) and highest (0.01 %) Tween 20 concentrations than at the other concentrations
(Fig.4b), the uniformity in droplet size across replicates was only observed in the 0.01 % Tween 20-sprayed leaves (Fig. 4b). This
is likely because the larger droplets in the 0.002 % Tween 20-sprayed leaves do not adhere to the leaf surface and roll off, leaving
behind the smaller droplets (Fig. 4a). Additionally, even though the 0.004 % Tween 20-sprayed leaves were effective in holding a
large number of droplets, the droplet size distribution was not as uniform across replicates as on the 0.01 % Tween 20-sprayed leaves.
Therefore, we observed the highest uniformity in droplet size and number in the leaves sprayed with the 0.01 % Tween 20 solution.

To determine the effect of Tween 20 on the uniformity of inoculum distribution within and across leaf samples, we sprayed
pea leaves with E. pisi conidial suspensions containing 10,000 conidia/ml in different Tween 20 concentrations. Our preliminary
experiments with a range of conidia concentrations (10,000 to 100,000/ml) showed that 10,000 conidia/ml provided the optimal
number to assess the uniformity of inoculum distribution and produce isolated colonies for disease symptom quantification (data not
shown). At 1 dpi, the sprayed pea leaves were harvested, and one-half was stained with trypan blue to visualize the fungal structures
under a microscope. We observed that with increasing Tween 20 concentration, the E. pisi conidia appeared more dispersed and less
clumped on the leaf surface (Fig. 5a). We used the Uniformity Index (UI) grading system developed in this study to quantify this
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Fig. 5. Effect of Tween 20 concentration on conidia distribution and germination a) Distribution of E. pisi conidia on pea leaf surface visualized
by trypan blue staining after spray inoculation with conidial suspension containing 0.002 %, 0.003 %, 0.004 %, or 0.01 % Tween 20 b) Bar graph
showing the mean uniformity index (+SEM) calculated based on the distribution of conidia in five FOV from eight leaves per Tween 20 treatment at
1 dpi. Statistical significance between treatments was computed using Brown-Forsythe and Welch-ANOVA tests (p < 0.0001) along with Dunnett’s
T3 multiple comparison test (« < 0.05) and is shown by different lower-case letters. ¢) Bar graph showing% germinated conidia at 2 dpi per leaf
for three leaves per Tween 20 treatment. Statistical significance between treatments was computed using One-way ANOVA and Tukey’s multiple
comparisons tests. Data was not significant.

observation. Based on our grading system, a Ul value between 4 and 7 indicates a uniform distribution of conidia. The average Ul
for the 0.01 % Tween 20-sprayed leaves was 4.2, significantly higher than the UI values (1.1-2.2) obtained for the other Tween 20
concentrations (Fig. 5b). To test whether Tween 20 affects the viability of E. pisi conidia, we calculated the percent of germinated
conidia at 2 dpi after spray inoculation. We did not observe a significant difference in conidia germination on leaves sprayed with
suspensions prepared in different Tween 20 concentrations (Fig. 5¢). The UI and conidia germination results confirm that conidial
suspensions made with 0.01 % Tween 20 provide an even distribution of inoculum across the leaf surface.

Reproducibility of the spray inoculation method, in terms of the initial amount of inoculum deposited on the leaf, is critical,
mainly when the goal is to compare the degree of infection between plant genotypes or treatments. To validate the reproducibility
of our method, we photographed pea leaves spray-inoculated with 10,000 conidia/ml suspensions (0.01 % Tween 20) at 7 dpi,
when white powder-like powdery mildew symptoms were visible on the pea leaf surface. We used the ImageJ software and the
semi-automated image analysis-based quantification plug-in developed in this study to quantify the percent of leaf area covered by
the disease (Fig. 6a). The image-based quantification revealed that ~40-50 % of the leaf area was covered with white powder-like
symptoms in leaf samples from two independent experiments (Fig. 6b). While experiment 2 replicate values were highly similar, two
of the four replicates in experiment 1 showed a slight deviation from the mean. This discrepancy may be attributed to the inherent
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Fig. 6. Quantification of powdery mildew disease symptoms via image-based analysis and RT-qPCR of fungal gene a) Left panel: Infected pea leaf
showing white colonies of powdery mildew at 7 dpi with 10,000 conidia/ml in 0.01 % Tween 20; Right panel: Region of Interest (ROI) selected
by the ImageJ plug-in for quantification of fungal area b) Bar graph showing mean (+SD)% pea leaf area covered by powdery mildew calculated
using ImageJ from 4 leaves each from two independent experiments ¢) Bar graph showing mean relative expression (+SD) of EpTub (E. pisi tubulin)
normalized to PsTub (P. sativum tubulin) at 7 dpi after spray inoculation from 3 biological replicates and two independent experiments.

biological variation in powdery mildew growth across replicate leaf samples or to the inability of the ImageJ software to capture all
infected areas accurately. To further assess the reproducibility of the spray inoculation method, we determined the fungal load on the
leaf at 7 dpi through RT-qPCR expression analysis of E. pisi tubulin. We found similar levels of Eptubulin expression across biological
replicates within an experiment and across experiments (Fig. 6¢), demonstrating the reproducibility of the spray inoculation method.

Our spray inoculation method represents a significant improvement over earlier methods [4,16] in terms of simplicity, cost, speed,
and application, as it does not require any specialized device, and is suitable for the inoculation of excised leaf segments as well as
intact plants. In terms of cost, we estimate a one-time investment of ~$100 for the simple airbrush (~$60) and haemocytometer ($30-
$50) used in the spray inoculation method reported here. The images for the ImageJ-based powdery mildew disease quantification
can be captured on a regular phone camera. In terms of time, the entire process, from conidia counting to spray inoculation, can be
achieved in <1 hour, and by following the simple on-screen instructions, a relatively inexperienced ImageJ user will be able to perform
the semi-automated disease symptom quantification method at the rate of ~ 1-2 min per leaf. Furthermore, in terms of application,
this method is especially suitable for studies comparing disease severity on wild-type and mutant plants or after treatment with
different antifungal compounds where tight control over the initial inoculum density is essential. In addition, an even distribution of
conidia over the leaf surface without clumping facilitates the development of isolated colonies, permitting accurate quantification of
fungal growth stages. Our quick and reproducible inoculation and quantification method can be easily extended to powdery mildews
infecting other plant species.

Limitations

Using our simple spray inoculation method, we were able to achieve moderate uniformity in inoculum distribution (average UI>4)
across the pea leaf with E. pisi conidial suspensions prepared in 0.01 % Tween 20. However, if cost is not an issue, it may be possible
to achieve higher uniformity by using more sophisticated airbrush devices that can reproducibly dispense a desired volume of liquid
per spray at a particular pressure [21]. In addition, while Tween 20 concentrations up to 0.01 % did not significantly impact conidia
germination, the germination rate of E. pisi conidia is slower after spray inoculation compared to the settling tower and brushing
methods. Therefore, the infection time points used to assess disease symptoms will have to be adjusted accordingly.
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